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* Apple and Mac are trademarks of Apple Inc., registered in the US. and other countries.

* Windows XP and Windows Vista are registered trademarks of Microsoft Corporation in the U.S.
and other counties.

* All product names and company names are the trademarks or registered trademarks of their
respective owners.

* Specifications and appearance are subject to change without notice for improvement.

Copyright Note

The use of copyrighted material for any purpose other than permitted uses such as personal or
home enjoyment, constitutes copyright infringement, and may incur penalties including damages
and restitution. The rights of the copyright holder also apply to recordings of, or derivative works
produced using copyrighted material, meaning that reuse or distribution of such material is also a
violation of copyright law. Korg Incorporated accepts no responsibility for any damages or penalties
you may incur due to any copyright violation you may commit. If you have any questions regarding

your rights to use copyrighted material, please consult a specialist in copyright law.

microSAMPLER Editor/Librarian Owner’s Manual



Introduction

Thank you for the Korg microSAMPLER. In order to take full advantage of the software, please read this
manual carefully and use the product as directed.

microSAMPLER Editor/Librarian in a Nutshell

The microSAMPLER Editor/Librarian enables you to edit microSAMPLER sample data and effect parameters
and transfer them between your microSAMPLER and a computer. The Editor/Librarian also allows you to
import WAV or AIFF format audio files and Standard MIDI files from a computer’s hard disk.

fapplications/KORG/ microSAMPLER | £

way AC BASS wav EDIT SAMPLES
way BRASS waw
waw CLAV . wav AUDIO IN
way EPIANO.way [ERKET]
= CTR me.wal" w Fx
w HIP HOP1 waw m
w HIP HOP2 wav
¥ MICROSMP.way BPM SYNC LOOP  REVERSE  LEVEL
i ORGAN.wav PARAMETEREDIT C#5  pron coana m OFF o~
Preset Patterns. msmpl_seq )
ae  Presec.msmpl_bank MICROSMP e “ O .:.I (_.NT “ [ o ..g
' TUNE " vRlOWT FX :
C » ) ( setectr ) ( eom ) ( PRocEss ) ~
4gkHz [ rravseecion [ Auto LAY I ~utoscrouL

o ) oo IR (5] onena oo [EERD) (<]

4

Precautions

A& Do not disconnect the microSAMPLER from the computer or turn off the power to the microSAMPLER
during the startup process of the microSAMPLER Editor/Librarian.
Do not operate the microSAMPLER or the microSAMPLER Editor/Librarian during data transfer.

Do not disconnect the audio interface for the microSAMPLER Editor/Librarian or turn off the power to
such the audio interface during the startup process of the microSAMPLER Editor/Librarian.

>

Do not connect multiple microSAMPLER units to your computer when you use the microSAMPLER Edi-
tor/Librarian.
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Notes on USB Communication

A4 You cannot use the microSAMPLER Editor/Librarian
along with a DAW or a similar application software that
communicates via MIDI.

The microSAMPLER supports USB-MIDI communication. However, the microSAMPLER communicates with
the microSAMPLER Editor/Librarian to send or receive large amounts of data, such as samples and pattern
data, using non-USB-MIDI standards. Therefore, you cannot use the microSAMPLER Editor/Librarian along
with a DAW or similar application that communicates via MIDI. Before you start using the microSAMPLER
Editor/Librarian, close all applications that communicate via MIDI.
Also, before using the microSAMPLER as a USB-MIDI device, you should close the microSAMPLER Editor/
Librarian, then start a MIDI-compatible application.
A& With Mac OS X, if you start a MIDI-compatible application while using microSAMPLER Editor /Librar-
ian, all connected MIDI devices will be disabled.
In this case, close the microSAMPLER Editor/Librarian and all MIDI-compatible applications first, then
restart the MIDI-compatible applications.

System Requirement

Mac OS X

Supported computer:

Supported OS:
Audio Interface:

Windows

Supported computer:

Supported OS:
Audio interface:

An Apple Macintosh computer that satisfies Mac OS X requirements, with Intel
or Power PC processor and USB port

Mac OS X 10.4 or later

An audio interface that supports CoreAudio and enables output at 44.1 kHz or
48 kHz (Macintosh built-in sound output can also be used.)

A computer that satisfies Microsoft Windows XP/Vista system requirements,
with a USB port (Intel USB chipset recommended)

Microsoft Windows XP SP3 or later, or Microsoft Windows Vista SP2 or later
An audio interface that supports ASIO or Direct Sound and enables output at
44.1 kHz or 48 kHz
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Installation

Installation on Windows

Follow the steps below to install the software on Windows:

1. Double-click “setup_E.exe” to start the installer. The installer screen opens.

2. Follow the instructions on screen to install the software.

Installation on Mac OS X

Follow the steps below to install the software on Mac OS X:
1. Double-click “microSAMPLER Editor.pkg” to start the installer. The installer screen opens.

2. Follow the instructions on screen to install the software.
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Quick Start

Starting Up microSAMPLER Editor/Librarian

[l Before you start using the microSAMPLER Editor/Librarian in Windows, you must install the Korg USB-
MIDI driver. Download the driver from the Korg website and install it as directed in the included docu-
mentation. (http:/ /www.korg.com/)

1. Connect the microSAMPLER to the computer using a USB cable.

2. Turn on the power to the microSAMPLER.

3. Double-click “microSAMPLER Editor Librarian” in the “microSAMPLER” folder inside the “KORG” folder.
Mac OS X: You can find the “KORG” folder in the “Applications” folder.
Windows: You can find the “KORG” folder by selecting [Start -> All Programs].
The microSAMPLER Editor/Librarian will starts up.

Setting Up microSAMPLER Editor/Librarian

Before using the microSAMPLER Editor/Librarian, follow the steps below to check the settings on the
microSAMPLER.

1. Press the [EDIT] button until it blinks.
If it is not blinking, press the [EDIT] button several times until it blinks.

2. Turn the [PARAMETER/FX CONTROL 1] knob to select the “GLOBAL” page.
3. Press the [EDIT] button to light it.
4. Turn the [PARAMETER/FX CONTROL 1] knob to select “PROTECT.” If “PROTECT” is set to “ON,” turn

the [VALUE /FX CONTROL 2] knob to select “OFE.”

Receiving Bank Data From the microSAMPLER

You can transfer the current bank data from the microSAMPLER to the microSAMPLER Editor/Librarian for
editing.

1. On the “Transfer” menu, select “Receive Current Bank.”

2. The current bank data will be copied from the microSAMPLER to the microSAMPLER Editor/Librarian.
A During data transfer, do NOT touch the microSAMPLER or the microSAMPLER Editor/Librarian.

What is the”“Current Bank”?

“Current bank” refers to the bank that is currently selected on the microSAMPLER. This includes samples,
sample parameters, pattern and effect data, along with tempo, audio-in and effect routing information.

The Bank Edit page of the microSAMPLER Editor/Librarian enables you to transmit and receive data to and
from the current bank of the microSAMPLER.

A& All of this data in the current bank will be lost if you turn off the power to the microSAMPLER or switch
to another bank. If you want to keep the data, you must save it to a user bank on the microSAMPLER
before turning off the power to the unit or switching banks.
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[ To back up the content of microSAMPLER's user banks to the microSAMPLER Editor/Librarian, use the

Bank Memory Control screen (see page 14).

Editing Sample Data

This section explains how to edit sample data in the Sample Edit page.
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1. Click the [EDIT SAMPLES] page select tab to display the Sample Edit page.
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2. Click a key on the Sample Select Keyboard where the sample that you wish to edit has been assigned.

The selected key will light-up.

3. Use the knobs and switches on the screen to edit the parameters for the selected sample.

[ Use the microSAMPLER to confirm that the pitch and volume parameters have been set appropriatelly.
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Loading WAV and AIFF Files

When WAV or AIFF files are imported into the microSAMPLER's Editor/Librarian they will be converted into
sample data that is compatible with the microSAMPLER.

1.

2.

In the Sample Edit page, select “Open Sample” from the “File” menu.
A dialog opens to prompt you to select a file.

Select a WAV or AIFF file, then click the [OPEN] button.
The selected sample data will be loaded.

[} The microSAMPLER Editor/Librarian supports WAV and AIFF files of 24-bit linear PCM mono and ste-

A

reo samples at 6/12/24/44.1/48 kHz. A sample file at 44.1 kHz will be automatically converted to a
sample file at 48 kHz before being loaded.

Samples at any sampling rate other than those specified above can be loaded, but the sample pitch will be
changed. If you wish to tune the sample to the original pitch, use the “SEMITONE” and “TUNE” sample
parameters on the Sample Edit page.

Transmitting Bank Data to microSAMPLER

To reflect edits performed in the microSAMPLER Editor/Librarian on the data in the microSAMPLER, you
must send the edited bank data to the microSAMPLER. To do so, follow the steps below:

1.
2.

A
A

In the “Transfer” menu, select “Transmit to Current Bank.”

A dialog is displayed to confirm the transmission. Click the [OK] button.
The edits of the microSAMPLER Editor/Librarian data will be reflected in the current bank of the
microSAMPLER.

Do not operate the microSAMPLER or the microSAMPLER Editor/Librarian during data transfer.

Bank data transmitted to the microSAMPLER’s current bank will be lost if you turn off the power to the
unit or switch to a different bank, unless you save the data in the micoSAMPLER. If you want to keep the
transmitted data, you must save it in the microSAMPLER.
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About the microSAMPLER Editor/Librarian’s
Screens and Features

This section includes an overview of each screen and its function in THE microSAMPLER Editor/Librarian.
For details about the parameters, please refer to the Owner’s Manual that came with the microSAMPLER.

Bank Edit Screen

Common Elements

The following elements are common to the Sample Edit, Effect Edit and Pattern Edit pages.

Bank name  Available memory space

g | o | SAMPLE.  microSAMPLER . .
L ; PRESET I - =
rm———— 2 . twmmmmz <5 [CONNECTED] indicator
' BANK BPM

wav AC BASS.wav i BANKEPMY 115
v BRASS.wav ! —

Page select tabs

Bank name
Enables you to edit the “BANK.NAME” (bank name) parameter.

Available memory space
Displays the USED AND available memory for samples and patterns in the bank.

[CONNECTEDY] indicator

Indicates the status of the connection to the microSAMPLER.
It lights up when the microSAMPLER is connected properly.

Page select tabs
Enables you to select the Sample Edit, Effect Edit or Pattern Edit page.

BANK BPM
Displays and enables you to edit the “BPM” (tempo) parameter for the bank.
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Sample Edit page

The Sample Edit page enables you to edit and control sample data.
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Preview button

Sample Select Keyboard

Enables you to select a sample to edit.

To swap a sample location, click on the original key and drag to another key.

To copy a sample, press and hold down the [Ctrl] key in Windows or the [option] key on Mac, click on the
original key and drag to another location.

[RECEIVE] button

Initiates the transfer of a sample from the microSAMPLER'’s current bank to the Sample Select Keyboard of
microSAMPLER Editor/Librarian.

[TRANSMIT] button

Transmits a sample from the selected key on the Sample Select Keyboard to the microSAMPLER’s current bank.

[AUDIO IN FX] button
Enables you to edit the “AUDIO IN FX SW” bank parameter.

Sample parameter sections

These sections display and enable you to edit the sample parameter settings.

[LOAD] button

Assigns and loads sample data from the file into the selected key on the Sample Select Keyboard.

[DELETE] button

Deletes a sample assigned to the selected key of the Sample Select Keyboard.

[WAVE EDITOR] button
Displays the Waveform Editor.
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Name of the original sample
Displays the name of the loaded audio file.

m Names with more than 16 characters will be truncated.

) Names with non-alphanumerical characters may not display correctly.

[Preview] button

Plays the sample assigned to the currently-selected sample key on the computer.

[ The playback of the sample will not reflect the pitch, volume or other parameter settings.

[SELECT] button

Selects “All” or converts the selected range into Start and End point settings.

[EDIT] button

Opens the “Edit” menu for the sample waveform.

[PROCESS] button

Processes an entire sample waveform, for examples converting the sampling rate.

Level meters
Display the preview playback volume level.

[PLAY SELECTION] button

Modifies waveform preview playback. Turn this On to preview only the selected range of the waveform.

[AUTO PLAY] button

Turns the Auto Play function On and Off. Turn the Auto Playback function On to automatically play a sample
whenever you select the Sample Select key where the sample is assigned.

[AUTO SCROLL]

Turns the Auto Scroll function On and Off. Turn the Auto Scroll function On to automatically scroll the sample
waveform during sample preview playback.

Sample waveform

This area displays the waveform of the sample assigned to the selected Sample Select key.
You can select a range of the waveform by clicking and dragging the mouse over the waveform.

Zoom in/out
Enlarge or shrink the size of the sample waveform display.
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Effect Edit Page

This page enables you to specify the effect type and various effect parameter settings.
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Effect parameters

[RECEIVE] button

Initiates the transfer of effect data from the microSAMPLER Editor/Librarian to the microSAMPLER's current
bank.

[TRANSMIT] button
Transmits the effect data from the microSAMPLER's current bank to the microSAMPLER Editor/Librarian.

Effect parameter section
This section displays and enables you to edit the effect type and each effect’s parameters.
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Pattern Edit Page

The Pattern Edit page enables you to edit and control pattern data.
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[RECEIVE] button

Initiates the transfer of data for all 16 patterns from the microSAMPLER Editor /Librarian to the microSAMPLER's
current bank.

[TRANSMIT] button

Transmits data for all 16 patterns from the microSAMPLER'S current bank to the microSAMPLER Editor/
Librarian.

[LOAD] button

Loads data for all 16 patterns from the Pattern Set file.

[SAVE] button

Saves data for all 16 patterns to the computer as the Pattern Set file.

[IMPORT SMF] button
Imports a Standard MIDI File into the selected pattern.

[ The content of the MIDI channel specified by “Global MIDI Channel” under the “microSAMPLER set-
tings” option in the Preference menu will be loaded as pattern data to be used in Sample mode. The
content of the MIDI channel specified by “Keyboard MIDI Channel” will be loaded as patterns to be used
in Keyboard mode. Program Change messages on the MIDI channel specified as “Keyboard MIDI Chan-
nel” will be loaded as sample numbers to be used in Keyboard mode.

[EXPORT SMF] button

Exports data for the selected pattern to the computer as a Standard MIDI File.

[ Patterns to be used in Sample mode will be saved on the MIDI channel specified by “Global MIDI Chan-
nel” under the “microSAMPLER settings” option in the Preference menu. Patterns to be used in Keyboard
mode will be saved on the MIDI channel specified by “Keyboard MIDI Channel.” Sample numbers to be
used in Keyboard mode will be saved as Program Change messages.
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Pattern data list

This list displays and enables you to edit settings for the 16 patterns.
To swap pattern locations, click on the pattern number, then, drag and drop the pattern data into the desired

pattern location.
To copy a pattern, press and hold down the [Ctrl] key in Windows or the [option] key on a Mac, click on the
pattern that you would like to copy and drag to another location.

File Browser

The Bank Edit screen enables you to view the hierarchy (tree) of directories (folders) and files on the computer’s
hard disk.

Preview button > AUTO PLAY
[AUTO PLAY]button —a————

File browser —5—

Preview button
Plays a preview of the audio file selected in the file browser.

[AUTO PLAY] button

Switches the Auto Play function On and Off.
Turn the Auto Play function On to automatically play an audio file when you select the file in the file browser.

File browser

Displays the files on the computer’s hard disk.
You can select audio and file trees and import them into the microSAMPLER Editor/Librarian.
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microSAMPLER Bank Memory Control Screen

The microSAMPLER Bank Memory Control screen enables you to back up all of the microSAMPLER data,
restore memory on the microSAMPLER using the backup file, and write and receive bank data to and from the
microSAMPLER’s specified user banks.

To access the Bank Memory Control screen, select “Control Bank Memory” in the “File” menu.

Backup All Data

You can back up all of the microSAMPLER user bank data and global data.

microSAMPLER Editor/Librarian

==\
Computer

Back up

Bank change Save

User banks
[AlBJc]DJEJF|G|H]

=)

microSAMPLER

®6 Bank Memory Control
//Backup Restore | Receive Bank \Write Bank \

[rtecterp—ry

You can back up all of the microSAMPLER user bank data and global data.

1. Click the [BACKUP] button. A dialog opens to prompt you to select a file.

N

Specify the location where you want to save the data, enter the file name, then click the [SAVE] button.

3. microSAMPLER Editor /Librarian receives global data and data from eight user banks, and saves the data
as a backup file in the computer.

A Do not touch the microSAMPLER or the microSAMPLER Editor/Librarian during data transfer.
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Restore From Backup File

You can use the backup file to restore the data to the microSAMPLER.

microSAMPLER Editor/Librarian

Computer

Restore

Bank change Save /
User banks
GLOBAL
(alsTcloleTFla]n] -]

microSAMPLER

—

00 Bank Memory Control

i Backué? Reslnm-(Receive Banl:_\{_Wrine Bank_\

You can use the backup file to restore the data to the microSAMPLER.

1. Click the [RESTORE] button. A dialog opens to prompt you to select a file.
Select the backup file, then click the [OPEN] button.

3. Data for the eight banks and global data will be transmitted to and stored in the microSAMPLER’s user
banks.
A Do not touch the microSAMPLER or the microSAMPLER Editor/Librarian during data transfer.

A
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Receive Bank Data

The microSAMPLER Editor/Librarian can receive bank data from a specified user bank of the microSAMPLER

and save the data as a file on your computer.

microSAMPLER Editor/Librarian

J
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The microSAMPLER Editor /Librarian can receive bank data from a specified
user bank of the microSAMPLER and save the data as a file on your computer.

1. Select the button for the microSAMPLER user bank where you want the microSAMPLER Editor/Librarian

to receive data from.

2. Click the [RECEIVE] button. A dialog opens to prompt you to specify a file.

&

Specify the location where you want to store the file, enter the file name, then click the [SAVE] button.

4. microSAMPLER Editor/Librarian will receive the bank data from the specified microSAMPLER user bank

and save it as a file on your computer.

A Do not touch the microSAMPLER or the microSAMPLER Editor/Librarian during data transfer.
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Write Bank Data

The microSAMPLER Editor/Librarian can load Bank Data files stored in the computer, then transmit and save
individual bank data to the corresponding user banks on the microSAMPLER.

microSAMPLER Editor/Librarian
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The microSAMPLER Editor fLibrarian can load Bank Data files stored in the
computer, then transmit and save individual bank data to the correspanding
user banks on the microSAMPLER.

1. Click the file select button located to the right of the file name field. A dialog opens to prompt you to select
a file.

Select the desired Bank Data file, then click the [OPEN] button.
Select the button for the bank containing the data that you wish to save to the microSAMPLER.
Click the [WRITE] button.

A B A

Bank data for the specified bank will be transferred to and saved in the corresponding user bank on the
microSAMPLER.

A Do not touch the microSAMPLER or the microSAMPLER Editor/Librarian during data transfer.
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Preferences

Select “Preferences...” on the “Edit” menu to open the Preferences panel.

® G Preferences

J_.-"r(_'ommon Audio Device .'\\micrOSAMF'LER Global Setting

Knob Mode Linear ?

af’: Displays an alarm prior to bank data transmission

General

“Displays an alarm prior to bank data transmission”
Check this box if you would like a prompt to appear when you attempt to transmit bank data to the
microSAMPLER.

Knob mode

You can specify your preferred knob operation method.
Linear: Drag the mouse up and down to operate the knobs.
Circular: Drag the mouse in circular motion to operate the knobs.

Audio device

Specifies an audio device tfor all sample playback.

Buffer size

Specifies the buffer size of the selected audio device. If the playback of a preview sample is interrupted, set this
size to a higher value. If there is a delay from the time you initiate the sample and when it plays, set this to a
lower value.

microSAMPLER Settings

On this tab page, you can set the Global parameters for the microSAMPLER. For more distorted on the Global
parameters, please refer to the microSAMPLER Owner’s Manual.

[RECEIVE] button

Loads the Global parameters from the microSAMPLER.

[WRITE] button
Writes the Global parameters to the micoSAMPLER.

) You cannot use the microSAMPLER Editor/Librarian to change the “Global MIDI Channel,” “Keyboard
MIDI Channel,” “MIDI Routing” and “Memory Protect” settings of the microSAMPLER.
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File Types and Description

The following file types can be loaded and saved in microSAMPLER Editor/Librarian:

Type Description Extension
Backup file A set of data for eight banks and global settings. msmpl_all
Bank Data file Data for one bank, which includes data for 36 samples, msmpl_bank

effects and 16 patterns.

Sample Data file | Data for one sample, which includes a sample and its msmpl_sample
parameters.

Pattern Set file Data for 16 patterns msmpl_seq

Global Data file Global data msmpl_glob
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Menus

“File” Menu Options

New
Creates new bank data.

Open

Loads bank data from a Bank Data file.

Save
Overwrites a Bank Data file with the bank data currently being edited.

Save As

Save the bank data currently being edited to the computer with a new name.

Refresh File Browser

Updates the file browser to the latest information.

Control Bank Memory
Displays the Bank Memory Control screen.

Close
Closes microSAMPLER Editor/Librarian.
Menu options available when the Sample Edit page is displayed:

Open Sample

Loads sample data from the file.

Save Sample

Saves sample data as a Sample Data file to the computer with a new name.

Export Sample in WAV Format

Exports sample data in WAV format to the computer with a new name.

Export Sample in AIFF format

Exports sample data in AIFF format to the computer with a new name.

Menu options available when the Pattern Edit page is displayed:

Open Pattern Set File

Loads data for 16 patterns from a Pattern Set file.

Save Pattern Set File

Saves data for 16 patterns as a Pattern Set file to the computer with a new name.
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Import Pattern Data from SMF
Imports a Standard MIDI File into the microSAMPLER Editor/Librarian.

Export Pattern Data to SMF

Exports pattern data to a Standard MIDI File format with a new name.

“Edit” Menu Options

Undo

Cancels the previous operation.

Redo

Restores the setting to the status obtained prior to the undo operation.

Preferences

Displays the Preferences panel.

Menu options when the Sample Edit page is displayed:
Cut

Cuts the sample data of the selected Sample Select key.

Copy

Copies the sample data of the selected Sample Select key.

Paste
Pastes the cut or copied sample data to the selected Sample Select key.

Clear
Clears the sample data from the selected Sample Select key.

Select All

Selects the entire range of the waveform.

Select Between Start/End Points

Selects the range between the Start and End points in the sample.

Convert Range to Start/End Points

Converts the selected range in the sample into Start and End points.

Menu options available when the Pattern Edit pageis displayed

Cut

Cuts the selected pattern data.

Copy

Copies the selected pattern data.

Paste
Pastes the cut or copied pattern data.
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Clear
Clears the selected pattern data.

“Transfer” Menu Options

Receive Current Bank

Receives data from the microSAMPLER’s current bank.

Transmit to Current Bank
Transmits bank data from the microSAMPLER Editor/Librarian to the microSAMPLER’s current bank.

Menu options available when the Sample Edit page is displayed:

Receive Sample Data

Receives sample data from the microSAMPLER's current bank.

Transmit Sample Data
Transmits sample data from the microSAMPLER Editor/Librarian to the microSAMPLER's current bank.

Menu options available when the Effect Edit page is displayed:

Receive Effect Data
Receives effect data from the microSAMPLER’s current bank.

Transmit Effect Data
Transmits effect data from the microSAMPLER Editor/Librarian to the microSAMPLER’s current bank.

Menu options available when the Pattern Edit page is displayed:

Receive Pattern Set
Receives a data set of 16 patterns from the microSAMPLER'’s current bank.

Transmit Pattern Set

Transmits a data set of 16 patterns from the microSAMPLER Editor/Librarian to the microSAMPLER’s current
bank.

“Help” Menu Option

Version
Displays the version information for the microSAMPLER Editor/Librarian.
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Troubleshooting

microSAMPLER Editor/Librarian does not start.

* Make sure that your computer satisfies the system requirements.

* Make sure that no other applications are running.
If any other application is running, the microSAMPLER Editor/Librarian may fail to start or transfer
data. Close all other applications, then check the operation of the microSAMPLER Editor/Librarian.

Data transfer fails.

* Make sure that the connected computer recognizes the microSAMPLER.
On Windows XP, check this on the “Hardware” tab by selecting [Control Panel -> Sound and Audio
Device -> Hardware].
On Windows Vista, verify this on the “Sound, Video and Game Controllers” tab by selecting [Control
Panel -> Hardware and Sound -> Display Hardware and Device -> Device Manager -> Sound, Video and
Game Controllers].
On Mac OS X, check this on the “MIDI Device” tab by selecting [Applications -> Utilities -> Audio MIDI
Setting -> MIDI Device]. After making sure that the microSAMPLER is recognized, close the “Audio
MIDI Setting” panel.

* In a Windows environment, check to see if the latest Korg USB-MIDI driver has been installed. You can
download the driver from the Korg website: http:/ /www.korg.com/

* Check to see if any applications that use MIDI-based communication other than the microSAMPLER
Editor/Librarian are running. If such applications are running, micoSAMPLER Editor/Librarian will
be unable to communicate with the microSAMPLER. Close the microSAMPLER Editor/Librarian and all
MIDI-compatible applications, then restart the microSAMPLER Editor/Librarian.

* Make sure that the “GLOBAL” page “PROTECT” setting on the microSAMPLER is turned “OFFE.” If it is
“ON,” change the setting to “OFFE.”

* Check the size of the microSAMPLER data.
Even if the memory space in the microSAMPLER Editor/Librarian is still available, transmitting sample
data and/or pattern data may fail if the current bank on the microSAMPLER has insufficient available
memory space. Execute “Transmit to Current Bank” to send the entire bank data from the microSAMPLER
Editor/Librarian to the current bank on the microSAMPLER.

* Make sure that your audio interface satisfies the operational requirements.

* Raise the value of “Buffer Size” on the “Audio Device” page in the Preferences panel. This may improve
skipping sound problems.
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